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U S E R  D O C U M E N T A T I O N

Frequently Asked
Questions
Organise every reference – and the labels you match. ARADAR is a

macOS reference library for music producers, with audio analysis

that tells you which labels your finished tracks belong on. The

answers below cover everything from your first import to

managing submissions.
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01 Getting Started

How do I add music to ARADAR?

Drag a folder from Finder onto the Library tab, or use File → Import Folder.

ARADAR scans the folder recursively and adds every supported audio file it

finds. Supported formats: AIFF, WAV, FLAC, MP3, M4A.

After import, each track is queued for audio analysis. Tracks appear in your

library as their analysis completes – not all at once. A progress panel shows

what's running.

What file format should I use?

AIFF. It's lossless, widely supported, and has consistent ID3 tag support across

every major DAW. When you drag an AIFF from ARADAR into Ableton or Logic it

imports instantly – no decode step, no background conversion.

WAV is hit-or-miss on metadata; many tools don't write tags to WAV files reliably,

so tracks land in ARADAR with empty artist, label, and BPM fields. FLAC requires

your DAW to transcode it to a working format on drag-in, which slows down your

session. MP3 is lossy – avoid it for references if you can.

If your library is already in WAV or FLAC, ARADAR will still import and analyse it

correctly – the format recommendation is about workflow friction, not a hard

requirement.



Why is my library empty after importing?

Analysis is still running. Tracks appear one by one as each file is processed, not

all at once when the import finishes. Check the progress panel in the corner of

the app – it shows how many tracks remain and an estimated time.

For a large library (5,000+ tracks) this can take several hours. You can quit

ARADAR at any time; analysis picks up from where it left off on the next launch.

What audio formats does ARADAR support?

AIFF, WAV, FLAC, MP3, and M4A.

AIFF is recommended for your reference library. It's lossless, has consistent ID3

tag support across DAWs, and drags into Ableton or Logic without a decode

step. WAV is hit-or-miss on metadata – many tools don't write tags to WAV

reliably. FLAC requires your DAW to transcode on drag-in, which adds friction.



What files does ARADAR skip during import?

Three categories are filtered automatically and surfaced in the import summary

sheet:

Not audio – files with an audio extension that aren't actually audio when

probed (renamed images, corrupt headers, random docs). Prevents broken

rows.

Remote files – files hosted on Google Drive, Dropbox, OneDrive, Box, or

iCloud Drive. ARADAR works only with files saved on your Mac. Save them

locally first to import them.

Likely samples – files shorter than 60 seconds. ARADAR is for tracking

released tracks and demos, not loops, one-shots, or stems. Samples pollute

label averages, frequency profiles, and fit scores. A 60-second minimum

catches the overwhelming majority of sample content (one-shots, drum loops,

vocal phrases) without false-positives on real tracks, which are almost always

90 seconds or longer.

The summary sheet at the end of each import lists every skipped file by

category with a disclosure showing the filenames, so you can spot anything

caught by mistake.

Will re-importing the same folder duplicate my tracks?

No. ARADAR deduplicates on file path during import – anything already in your

library is silently skipped. Drag the same folder twice, drag a track out into a

DAW and the same file back in later, or include a previously-imported folder

inside a larger drop: in every case, only new files are added. Nothing is

overwritten, no metadata is touched.

Can I import tracks that are stored on an external drive or NAS?

Yes. ARADAR stores a security-scoped bookmark to each file, not just its path,

so it can access the file regardless of where it lives. If the drive isn't mounted

when you launch ARADAR, those tracks show as Unreachable until the drive

comes back online – then they're accessible again without any manual steps.



Why are some tracks showing in red with "permission denied"?

macOS blocked ARADAR from reading the file. This usually happens after a

system update, or when tracks live in a folder ARADAR was never granted

access to (Desktop, Documents, Downloads, an external drive, a network share).

A banner at the top of the Library shows how many tracks are affected. Click

Open Full Disk Access… to jump directly to System Settings → Privacy &

Security → Full Disk Access.

If ARADAR isn't already listed there, click the + button below the list and select

ARADAR from /Applications, then make sure its toggle is on. ARADAR is

intentionally not sandboxed (so it can read tracks from anywhere on your Mac,

including external drives and synced folders), which means macOS only lists it in

the per-folder grant panes after it has tried to access a protected folder. Full Disk

Access avoids that bootstrap problem entirely – once granted, every previously

denied track works again.

After granting access, right-click the affected tracks and choose Retry Analysis.

What metadata does ARADAR read from my files?

Artist, title, label, genre, year, BPM, and key – read from embedded ID3 tags at

import time. If tags are missing or wrong, they'll be blank or incorrect in

ARADAR. ARADAR doesn't write back to your files.
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02 Audio Analysis

What does ARADAR actually measure?

For each track, ARADAR runs three measurements using the bundled ffmpeg:

Loudness (via ebur128): integrated LUFS, loudness range (LRA), true peak

Dynamics (via astats): RMS level, crest factor

Frequency profile (via custom FFT): 10-band spectrum with a +4.5 dB/octave

tilt

Results are stored in the local database and used for the Inspector, the Labels

tab aggregations, and the frequency profile charts.

Why do some tracks show "Failed"?

Analysis failed after three attempts. Common causes: corrupted file, a renamed

file whose actual format doesn't match its extension (e.g., an MP3 renamed to

.wav ), or file permission issues.

Right-click the track → Reveal in Finder to confirm the file opens. Then right-

click → Retry Analysis. If it keeps failing, the file itself is likely the issue. You can

select multiple failed tracks and retry them in bulk.



Why do some tracks show "Unreachable"?

The file was moved, renamed, or deleted after you imported it. ARADAR's

bookmark to the file can no longer resolve.

Try right-click → Retry Analysis – if the file is back in its original location, this

picks it up immediately. If not, remove the track and re-import from its new

location. A manual relink feature is planned for a future version.

Can I cancel analysis mid-run?

Yes – click Cancel on the progress panel and confirm. All pending tracks are

removed from your library. Completed and failed tracks are unaffected. There's

no undo, but re-importing the batch after cancelling brings everything back.

Does analysis run in the background if I switch tabs?

Yes. Analysis runs as a background service; you can use all other parts of

ARADAR while it runs. The progress panel floats in the corner until the queue

empties.

Why does the panel look different when I re-analyse a single track?

Single-track re-analysis (Inspector → Retry Analysis, or right-click → Re-

analyse) shows a simplified version of the panel – just a spinner and the file

name, no progress ticker, no Cancel button. There's nothing meaningful to count

down with one track, so the noise is stripped out. The full panel returns

whenever a bulk import is running.
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What is the frequency profile chart showing?

The chart shows how a track's frequency balance differs from a reference

curve – not the track's absolute spectrum. The 0 dB line represents the

reference. Points above 0 mean the track has more energy in that band than the

reference; points below mean less.

A flat line at 0 dB means perfect match to the reference. Real tracks will deviate

– the question is whether those deviations matter for what you're trying to do.

Do I need to align tracks by loudness before comparing them?

No. ARADAR normalises each track by its own total spectral energy before

comparison, so the chart shows tonal shape, not absolute level. A quieter copy

and a louder copy of the same track draw identical curves. No LUFS matching

needed.



What are the built-in reference curves?

Five genre baselines – Electronic, Hip-Hop, Pop/Rock, Acoustic, Orchestral –

plus one mathematical reference, Pink Noise.

The genre curves are intentionally broad: useful for rough tonal sanity checks

but not precise enough for label-level targeting. Pink Noise is a mathematical

baseline (equal energy per octave) – a mastering yardstick rather than a genre

target. Most music shows a low-end drop against pink and a roughly flat upper

region; the differences between tracks usually live in the genre curves, not in

pink.

For label-specific targeting, build a custom curve from that label's actual tracks.

See Custom Reference Curves in the help doc.

What is a custom reference curve?

A frequency profile you build from your own track selection. Select 3 or more

tracks in the Library or My Tracks tab → right-click → Create Custom Reference

Curve → give it a name.

ARADAR computes the median 10-band spectrum across those tracks and saves

it as a named reference. Once created, it appears in the reference picker

alongside the built-in curves.

Typical use: select 10–15 tracks from a label you're targeting, save as "[Label

Name]". Now every track in your library can be measured against that label's

sonic identity.



What's the shaded band on the frequency chart?

When a custom curve is selected, a shaded band appears around the 0 dB line.

This is the ±1 standard deviation corridor – how much the tracks used to build

the curve varied from each other, per band.

Your track's curve inside the band: tonally consistent with what that label

releases.

Your track's curve outside the band: a noticeable outlier in that frequency

region relative to the label's catalogue.

The band doesn't appear for built-in curves – they're archetypes, not derived

from a real catalogue, so variance around them wouldn't mean anything.

A narrow band means the label is tonally consistent. A wide band means their

catalogue varies a lot – tonal match matters less.

What's the Tonal deviation number in the comparison view?

A single number summarising how far a track's 10-band spectrum sits from the

selected reference, in dB. Computed as the root mean square of the per-band

deviations.

Lower is closer. Roughly:

Under 2 dB: strong tonal match – little to no tonal adjustments needed

2–4.5 dB: moderate deviation – detectable differences, may or may not matter

for the label

Over 4.5 dB: significant deviation – obvious tonal mismatch relative to this

reference

These aren't hard thresholds. A 5 dB deviation in the mids on a label that

releases bass-forward music might be fine. Use the number to rank and

compare, not as a pass/fail gate.



How do I compare multiple tracks against a reference?

Select 2 or more tracks (up to 10) in the Library or My Tracks tab → right-click →

Compare Frequency Profiles.

The comparison sheet overlays all selected tracks on one chart with distinct

colours, shows the reference curve and shaded corridor, and lists each track

with its tonal deviation. Sort by deviation to find your strongest match. Click a

track row to highlight its curve and fade the others.

Can I compare multiple labels against a reference?

Yes. In the Labels tab, select 2 to 10 labels → right-click → Compare Frequency

Profiles…. The same comparison sheet opens as the tracks flow, but each row

in the legend is a label name + track count instead of title + artist. Useful for

spotting which labels in your catalogue cluster around the same tonal balance –

sister labels, sub-genre families, or alternate-target candidates when your first-

choice label isn't biting.

What happens when I click a row in Label Matches?

That label's median frequency profile becomes the active reference curve in the

Frequency Profile chart above – the chart immediately re-draws to show how the

current track sits relative to what that label typically releases. A pill below the

section title reads "vs [Label Name] · N tracks · NN%". If the label has 3 or more

analysed tracks, the ±1σ corridor also appears around 0 dB.

The overlay is transient – it lives only while the current track's Inspector is open.

Re-opening the same track resets the chart to the global default reference. To

pick a different label, click another row. To return to a preset or custom curve,

use the "vs ..." picker just under the section title (it intentionally lists only built-

ins and custom curves, not labels – labels are picked from the matches list).
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04 Library and Organisation

How do I filter the library?

Use the dropdowns above the track list: Label, Key, Year, BPM, Rating. Combine

any of them – they stack as AND filters. The search box adds free-text matching

on top. Active filters appear as chips with × to remove them individually.

To see every track for a specific label, artist, genre, year, etc., right-click any

track → Show All Tracks → pick the facet. The library clears all active filters first

and applies only the picked one, so you always get the full set for that facet – no

stray search query or year filter silently narrowing the result. The same "clean

slate" behaviour applies to View Tracks in the Labels view and to clicking an

artist name in the Label Inspector.

How do I rate tracks?

Right-click any track → Rating → pick a star level (0–5). You can also click the

stars in the Inspector panel (open it by clicking a track). Ratings filter with the

Rating dropdown – set a minimum and the library shows only tracks at that level

or above.

Can I create playlists?

Yes – use File → New Playlist… (⇧⌘N) or right-click a track → Add to Playlist.

Multi-selection works too: select several tracks first, then right-click → Add to

Playlist to add them all in one go. Playlists appear in the sidebar.



How do I drag a track into my DAW?

Click and drag any track row from ARADAR directly into Ableton, Logic, or any

other DAW's arrangement or session view. ARADAR hands the original file path

to the DAW – no copy is made.

If the drag seems to do nothing, confirm the track's status is Analysed. Pending

or Failed tracks may not resolve correctly.

Can I edit track metadata inside ARADAR?

Yes. Click a track to open the Inspector and the metadata fields (title, artist,

album, label, genre, year, BPM, key, notes) are all editable inline. Changes are

saved to the ARADAR database immediately – they don't write back to the

original file's ID3 tags.

What are tags and how do I use them?

Tags are freeform labels you attach to tracks for any organising scheme that

doesn't fit the built-in fields – mood ( dark , uplifting ), purpose ( set-

opener , peak-time ), production state ( needs-mastering , pitched ), reference

category ( kick-reference , vocal-reference ), whatever helps you find tracks

later.

Open the Inspector, type into the Tags field, press return to commit each tag.

Existing tags auto-complete so you don't end up with darks , dark , and DARK

as separate values. Remove a tag by clicking its × chip. Search by typing the tag

text in the Library search box.

Tags live in ARADAR's database only – they're not written back to the original

file's ID3 tags.
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How do I change the theme?

Preferences → Appearance → pick a theme. The whole app updates

immediately, including charts and the frequency-corridor shading. There's also a

quick switcher in the toolbar.

What's the difference between the themes?

Nocturne – deep neutral dark theme, low-contrast, designed for long studio

sessions. Default for most users.

Pulse – saturated dark theme with stronger accent colours.

Velvet – warm dark theme with reduced blue light, easier on the eyes late at

night.

Open Air – bespoke light theme for bright rooms or screen-sharing.

System (Light) – system-style light theme using Apple's native appearance

colours.

System (Dark) – system-style dark theme using Apple's native appearance

colours.

Pick whichever your eyes prefer. Visual hierarchy, data colours, and contrast are

all calibrated per theme – none of them sacrifice readability.



ARADAR · FAQ LABELS TAB

06 Labels Tab

How does ARADAR know which label a track belongs to?

From the Label field in the track's ID3 tags. If a track has no label tag, it won't

appear under any label in the Labels tab.

What are the loudness metrics in the Labels tab?

Aggregations computed across all analysed tracks on that label:

Avg LUFS: average integrated loudness – how loud the label masters

LUFS Range: spread between the quietest and loudest tracks on the label

Avg Crest: average crest factor – higher means more dynamic, lower means

more compressed

Avg RMS: average RMS level

These are useful for understanding a label's mastering style before you pitch.

What are the frequency band columns?

The Labels tab doesn't have per-band columns. Frequency data is in the Label

Inspector – click a label row to open it and see the full 10-band frequency profile

for that label's catalogue.
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How does ARADAR decide which labels match my track?

ARADAR ranks labels using a composite score: frequency profile match (40%),

loudness match (25%), tempo match (20%), and genre match (15%). The

frequency dimension is the strongest – it's based on how closely your track's 10-

band balance matches analysed tracks in your library whose Label metadata

field matches each label's name (not custom Tags).

Labels without frequency data (no analysed tracks tagged to them in your

library) are scored on the other three dimensions only and show "Freq –" in the

breakdown.

The dropdown sorts all your labels by composite score, highest first. If a label

you want to submit to doesn't rank highly, it usually means your track is

significantly off-profile on one of the four dimensions – the breakdown in the

inspector shows which.

You can still submit to any label manually from the Labels tab. The dropdown is a

shortcut for likely matches, not a hard filter.

My track has no genre or BPM tag – does that hurt the score?

Yes. The 15% genre weight and 20% BPM weight can only contribute when

those tags exist on your track. A track with neither tag caps at 65% no matter

how good the loudness and frequency fit is. Open the Inspector, fill in the

missing fields, and the label matches recompute. This is the single most

common reason scores look mysteriously low.



What does the "N tracks" pill next to a label mean?

It's the number of analysed tracks ARADAR has on hand for that label's

frequency profile (tracks whose Label field matches that label). The pill is always

visible – useful for seeing how much evidence backs each score (an 89% match

from 12 tracks is more trustworthy than the same 89% from 2). Fewer tracks

means lower confidence, so ARADAR dampens the composite score to reflect

that. Profiles built from 8 or more tracks are considered fully reliable. To grow a

label's profile, import more of their releases and ensure their Label metadata

matches.

How do I make ARADAR's scoring more or less strict?

Preferences → Audio Analysis → Fit Scoring has a Lenient / Balanced / Strict

picker. Lenient surfaces more labels as fits, Strict only the most confident

matches. Balanced is the default tuning. The setting takes effect immediately –

re-open a track Inspector to see the recomputed scores.

How many labels show up in the Label Matches list?

Five by default. Adjust in Preferences → Audio Analysis → Label Matches →

Matches Shown – range is 3–10. Use a tighter shortlist for a focused workflow,

or a longer list to explore lower-confidence fits. Changes take effect

immediately; re-open a track to see the new list length.

How do I log a submission?

Right-click a track in the Library → Add Submission to Label → choose the label.

The submission appears in the A&R Tracker tab with status draft .

What submission statuses are available?

Draft, Submitted, Responded, Accepted, Rejected. Update a submission's status

as the conversation progresses by clicking the status badge in A&R Tracker.



Can I add notes to a submission?

Yes – click a submission row to expand it and add free-text notes. Useful for

tracking who you contacted, what response you got, and any follow-up.
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How do I open the Statistics window?

⇧⌘S , or Window → Library Statistics. It opens as a separate window – leave it

on a second monitor while you work.

What's in the Statistics window?

Overview – totals (tracks, labels, hours of music) and library-wide averages

(LUFS, crest, BPM).

Top Lists – top labels by track count, top genres, top years.

Distributions – histograms of BPM, key, year, and rating.

Quality Averages – average loudness and dynamics by year, useful for

spotting how mastering style in your reference collection has shifted over

time.

Action Items – tracks needing attention (missing metadata, failed analysis,

unrated, untagged). Click any row to jump to those tracks with the right

Library filter applied.

Submissions – pipeline summary by status, average response time, top labels

you've submitted to.
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Is there a free trial?

Yes – 14 days, full features. Nothing is gated during the trial; you're evaluating

the real app, not a demo.

What happens when the trial ends?

Your library, ratings, submissions, tags, custom curves, and analysis data stay

accessible – you can browse, filter, listen, drag into your DAW, and view

analysis. What's locked is creating new content: importing new tracks, creating

new custom reference curves, logging new submissions, adding new tags.

Buying a license lifts the lock instantly.

How do I purchase?

Click Buy ARADAR in the trial banner above the library or in Preferences →

License. The button opens the ARADAR store at shop.aradar.app . Lemon

Squeezy handles checkout as the Merchant of Record (they invoice, manage

taxes, and issue your receipt).



How do I activate my license?

Two paths:

1 One-click from the email. The Lemon Squeezy receipt has an "Activate

ARADAR" button. Click it on the Mac where you want ARADAR licensed –

the app opens, jumps to the License tab, prefills the key, and runs

activation automatically.

2 Manual paste. Copy the license key from the email → Preferences →

License → paste into the License Key field → click Activate.

Either way the License tab confirms with a green success message once

activation completes.

How many Macs can I use one license on?

Three. Studio Mac, laptop, spare – or whatever combination you prefer. You

don't need to use all three slots.

"Activation limit reached" – what now?

You've already activated on 3 Macs. To free a slot:

Best path: open ARADAR on a Mac you no longer use → Preferences →

License → Deactivate This Mac. The slot is released immediately, and you can

activate on the new Mac.

No access to the old Mac: email hello@aradar.app with your license key and

we'll free the slot.



Activation shows "Unexpected response from license server" – what
now?

The license server returned something ARADAR didn't recognise. The banner

quotes the exact message the server sent back, and a Contact Support button

opens a pre-filled email.

Two things to try:

1 Wait a minute and retry. Many of these are transient and clear themselves.

2 If the message persists, click Contact Support and include the quoted text

from the banner. The exact wording maps to a specific Lemon Squeezy

condition.

Unrecognised server messages are reported to Sentry automatically (no license

key, no email – just the message text and version info), so the underlying cause

is often patched before you need to write in.

Can I use ARADAR offline?

Yes. Once activated, ARADAR validates with the license server in the

background. If you're offline (no network, on a plane) the app stays fully

licensed for 30 days without contacting the server. The status badge in

Preferences → License shows "Licensed (offline N days)" so you can see how

long it's been since the last successful check.

After 30 days offline the license falls back to "invalid" and content-creation

features lock – exactly like the trial ending. The moment you reconnect and

ARADAR successfully revalidates, full access returns automatically.

How do I free a slot before selling or wiping a Mac?

Before you sell, give away, or wipe a Mac, open Preferences → License →

Deactivate This Mac. The slot is released back to your pool. If you forget, email

hello@aradar.app with your license key.



Where's my receipt?

In your email – search your inbox for "Lemon Squeezy" or for the ARADAR store

name. The receipt has a "View Order" link that opens your order page, where

you can re-download the receipt, see the license key, request a refund within

the policy window, or update payment details for subscription renewals.

Is my license tied to my email address?

No. The license key is the credential. We don't store your email in ARADAR, and

we don't require an account or login. (Lemon Squeezy has your email from the

purchase for billing purposes – that's their record, not ours.)
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Where does ARADAR store its data?

All data lives locally in ~/Library/Application Support/aradar/ . The database

is library.sqlite . Artwork cache is in the artwork/  subfolder. Nothing in

your library is uploaded.

How do I export logs for troubleshooting?

Preferences → Diagnostics → Export Log as File. Attach the file to your support

email with a description of what you were doing. Logs reflect the current session

– if you restarted ARADAR since the issue occurred, reproduce it first.



What data does ARADAR send over the network?

Your library, audio files, listening history, ratings, tags, custom curves, and

submissions never leave your Mac. There's no telemetry on how you use the

app.

Three narrow exceptions, all tied to paid use:

1 License activation, validation, and deactivation – sends your license key

and this Mac's name to api.lemonsqueezy.com  for the license server to

manage your activation slots. No library data is included. Validation re-runs

periodically; deactivation releases the slot.

2 Crash reporting – when ARADAR crashes or hits an unhandled error, a

report is sent to Sentry (stack trace, OS version, app version, error type).

No file paths, track names, license key, or email. Opt-out toggle in

Preferences → Diagnostics → Crash Reporting.

3 Update checks – ARADAR fetches the appcast at aradar.app/appcast.xml

on launch and once a day to learn whether a new version is available. Just

an HTTPS GET; no identifiers sent. Updates are EdDSA-signed so a

hijacked feed can't push a tampered build.

That's the whole list. No analytics, no usage telemetry, no "phone home" to

count users.

Can I turn off crash reporting?

Yes. Preferences → Diagnostics → Crash Reporting → toggle off. Takes effect

immediately; no restart needed. Crash reports are sanitised (no file paths, no

track or label names, no license key, no personal identifiers) so leaving it on

helps fix bugs without exposing your library.



Why does ARADAR need permission to access my files?

macOS protects certain folders (Desktop, Documents, Downloads, external

drives, network shares) and requires apps to explicitly request access. ARADAR

is intentionally not sandboxed, so it can read your music from anywhere on disk

– but the trade-off is that for files in protected locations you need to grant Full

Disk Access once. After that, every track is reachable indefinitely without further

prompts.

ARADAR also stores a security-scoped bookmark for each imported track.

Bookmarks survive renames and moves better than raw file paths, and let

ARADAR reach the file on every subsequent launch without re-asking permission

per file.
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Still stuck? Export a diagnostic log from Preferences → Diagnostics and

send it our way with a short note on what you were doing.

hello@aradar.app →


